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 UVOD 

Rad obrađuje primjenu geografskih informacijskih sustava (u daljnjem tekstu ,,GIS'') u 

gospodarenju reziduima. Primjena GIS tehnologije omogućuju lakše prikazivanje podataka 

dobivenih istraživanjima na lokaciji zahvata i daje preglednost rezultata povezivanjem 

podataka s geografskim kartama i terenom. Rad se sastoji od dva dijela teoretskog i 

praktičnog. U teoretskom dijelu su ukratko objašnjeni pojmovi vezani uz radionuklide i 

radioaktivnost, lokacije s reziudima u Republici Hrvatskoj i odlagalište pepela i šljake 

termoelektrane tvornice Jugovinil u Kaštelu Sućurcu, naselju u gradu Kaštela. U praktičnom 

dijelu su obrađeni podaci dobiveni istraživanjima na lokaciji odlagališta pepela i šljake 

termoelektrane bivše tvornice Jugovinil u Kaštelama te su prikazani pomoću GIS 

tehnologije. Svrha ovog rada je prikazati mogućnosti i prednosti korištenja GIS-a u 

gospodarenju reziduima. 
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 REZIDUI 

Pojam rezidui, u Republici hrvatskoj, zakonski je definiran pravilnikom o praćenju stanja 

radioaktivnosti u okolišu u članku 3. (NN RH 40/18) te glasi ,,rezidui jest materijal koji ostaje 

nakon industrijskog procesa a koji se sastoji od ili koji je onečišćen prirodnim 

radionuklidima i nastaje u industrijskim sektorima koji su navedeni u točki A Priloga 2. koji 

je sastavni dio ovoga Pravilnika'' (Veinović, 2018.) definiraju pojam rezidui kao ,,novi naziv 

za prirodno radioaktivne materijale koncentrirane industrijskim ili drugim aktivnostima i 

predstavljaju specifičnu kategoriju industrijskog nusproizvoda koja se ne vodi kao otpad u 

užem smislu, niti kao radioaktivni otpad.'' (p. 1.). Rezidui kao takvi, ako nisu zbrinuti na 

pravilan način, mogu predstavljati opasnost za zdravlje ljudi i okoliš. U reziduima se može 

pojavljivati široki spektar radionuklida sa vrlo različitim vremenima poluraspada tako da je 

prije zbrinjavanja istih potrebno odrediti vrste i količine radionuklida u njima. Problematika 

gospodarenja reziduima leži u njihovom zbrinjavanju ili iskorištenju na način na koji oni ne 

bi bili štetni za okoliš. Isto tako rad sa tvarima koje imaju povećane koncentracije 

radionuklida može loše utjecati na zdravlje radnika koji su direktno izloženi tim 

materijalima. Sama kompleksnost te problematike najviše se odražava na sigurnosne aspekte 

gospodarenja reziduima. 

Primarna karakteristika radioaktivnih materijala u reziduima je ionizirajuće zračenje. 

Ionizirajuće zračenje je pojava prijenosa energije u obliku fotona ili masenih čestica koje 

ima dovoljno energije da u međudjelovanju s kemijskom tvari ionizira tu tvar. U 

međudjelovanju s tvari dolazi do izmjene energije i izmjene strukture ozračene tvari. 

Posljedice mogu biti korisne ili vrlo štetne (Dežalija, 2006). 

Postoji nekoliko načina mjerenja radioaktivnosti i zračenja pojedinih tvari. 

Ukupna radioaktivnost (A) radionuklida izražava se brojem raspada u jedinici vremena (Bq). 

 𝐴 =
௥௔௦௣௔ௗ

௧
  [𝐵𝑞]       (2-1) 

Gdje je:  A – ukupna radioaktivnost 

               t – vrijeme (s) 

                

Specifična radioaktivnost (B) je radioaktivnost specifične mase ili volumena tvari. Izražava 

se u Bq po jedinici mase ili u Bq po jedinici volumena. 

                                                                 𝐵 =
஺

௠
 [

஻௤

௞௚
]                                    (2-2) 

Ili 
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                                                                 𝐵 =
஺

௏
 [

஻௤

௠య
]                                    (2-3) 

Gdje je: B – specifična radioaktivnost 

              m – masa (kg) 

              V – volumen (m3) 

 

Doza ionizirajućeg zračenja označava količinu predane energije određenoj masi tvari. 

Apsorbirana doza (D) je količina energije ionizirajućeg zračenja koju apsorbira tvar na koju 

djeluje zračenje. Mjerna jedinica je Gy (Grey) 

                                                              𝐷 =
ா

௠
 ቂ

௃

௞௚
ቃ , [𝐺𝑦]                             (2-4) 

Gdje je : D – doza ionizirajućeg zračenja (Gy) 

               E – predana energija (J) 

 

Brzina apsorbirane doze je količina energije ionizirajućeg zračenja koju tvar na koju djeluje 

zračenje apsorbira u jedinici vremena. Izražava se u Gy/s. 

                                                                   𝑣𝐷 =  
஽

௧
  [

ீ௬

௦
]                               (2-5) 

Gdje je: vD – brzina apsorbirane doze (Gy/s) 

 

Mjerenje brzine apsorbirane doze je važno jer vrijeme izloženosti zračenju bitno utječe na 

oštećenje strukture tvari koja je izložena ionizirajućem zračenju te na moguće štetne 

posljedice po žive organizme.  

 

 

 

2.1. Prirodni radionuklidi 

Prirodni radionuklidi prisutni su u okolišu te su gotovo svi produkti raspada uranijskog, 

torijskog ili aktinijskog niza (slika 2-1). Prirodni radionuklidi mogu emitirati alfa, beta i/ili 

gama zračenje te su time štetni za ljude i sve žive organizme ukoliko se nađu u međusobnom 

kontaktu. Njihova koncentracija u prirodi znatno varira ovisno o području na kojemu se 

nalaze. Mjesta s povećanim koncentracijama prirodnih radionuklida su, prema Pravilniku o 

praćenju stanja radioaktivnosti u okolišu (NN RH 40/18), spilje, toplice/lječilišta i rudnici. 

Na svijetu postoje određene lokacije s izrazito povišenim koncentracijama ionizirajućeg 

zračenja koje je posljedica visoke koncentracije prirodnih radionuklida na tim lokacijama. 
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Raznim ljudskim djelatnostima (spaljivanje ugljena u termoelektranama, eksploatacija nafte 

i plina…), u kojima se upotrebljavaju prirodni materijali, može doći do njihovog 

koncentriranja te mogu postati štetni za okoliš. Povećanje koncentracije radionuklida se 

odvija na način da količina radionuklida u materijalu ostaje ista, dok se volumen samog 

materijala znatno smanjuje. 

 
Slika 2-1 Uranijski i torijski niz (Enciklopedija.hr) 

 

2.2. Rezidui u Republici Hrvatskoj 

U Republici Hrvatskoj rezidui se nalaze na sljedećim lokacijama: 

1) Odlagalište pepela i šljake termoelektrana Plomin I i II 

2) Odlagalište fosfogipsa tvornice Petrokemija d.d. u Kutini 

3) Odlagalište pepela i šljake bivše termoelektrane u Kaštelanskom zaljevu u dvorištu 

bivše tvornice Jugovinil  

4) Lokacije na kojima se obavlja eksploatacija nafte i plina ili lokacije na kojima se 

obavlja čišćenje cijevi korištenih za pridobivanje nafte i plina (Veinović et al., 2022). 

 

Termoelektrana Plomin nalazi se u Istri, na kraju Plominskog zaljeva. Postrojenje Plomin I 

u radu je od 1970. godine (slika 2-2). U početku rada se za dobivanje električne energije 

koristio domaći ugljen (antracit) iz istarskih ugljenokopa, te lignit i smeđi ugljen iz Bosne i 

Hercegovine. Navedeni ugljeni sadrže povećanu koncentraciju radionuklida i sumpora te 

njihovim izgaranjem u postrojenju nastaje pepeo i šljaka povećane radioaktivnosti. 

Odlagalište pepela i šljake je pod stalnim nadzorom Instituta za medicinska istraživanja i 

medicinu rada čiji članak tvrdi da je ,,Početkom rada TE Pogona I odlagalište pepela i šljake 

bilo je smješteno blizu termoelektrane, u maloj uvali, kao hrpa otpada koji se sakuplja 
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tijekom rutinske operacije. Kasnije je preko odlagališta, kao i na stranama, postavljen 

pokrov od geosintetičkog materijala, te prekriveni slojem zemlje debljine 40 - 60 cm i trava 

je posijana preko svega. Izgrađeni su kanal za odvod oborinske vode i taložni tank, a oko 

cijelog odlagališta postavljena je žičana mreža.'' (Kovač i Marović, 2008). 

 
Slika 2-2. Plomin I i odlagalište pepela i šljake (HEP d.o.o.) 

 

Tvornica Petrokemija d.d. nalazi se u Kutini (slika 2-3). Tvornica ,uz ostale proizvode, 

proizvodi fosfatna mineralna gnojiva. Prilikom proizvodnje fosfatnih mineralnih gnojiva 

nastaje fosfogips kao otpadni materijal proizvodnog procesa. Fosfogips se odlaže na 

odlagalište. Za proizvodnju fosfatnih mineralnih gnojiva koristi se ruda bogata fosforom 

koja ima povišenu prirodnu radioaktivnost. Proizvodnim procesom većina radionuklida 

ostaje koncentrirana u fosfogipsu. Institut za medicinska istraživanja i medicinu rada obavlja 

kontrolu radioaktivnosti na odlagalištu i oko odlagališta kako bi se na vrijeme uočilo 

možebitno prodiranje radionuklida u okoliš (Bituh, 2012). 
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Slika 2-3. Lokacija postrojenja tvornice Petrokemija d.d. i odlagališta fosfogipsa (Petrokemija d.d.) 

 

U Republici Hrvatskoj nafta se pridobiva na području panonskog bazena, a na području 

Jadranskog mora pridobiva se prirodni plin (Kišić, 2015). Prilikom eksploatacije nafte i 

prirodnog plina postoji mogućnost dovođenja u kontakt alata koji se koriste za eksploataciju 

i radioaktivnih materijala koji se nalaze pod zemljom, u stijenskoj masi ili u ležištima 

ugljikovodika. Radionuklidi se najčešće nakupljaju kao talog na cijevima korištenima za 

eksploataciju (slika 2-4). Takav talog, ne samo što smanjuje promjer cijevi i smanjuje protok 

kroz cijev, nego također može sadržavati radionuklide. Cijevi kontaminirane talogom koji 

sadrži povećane razine radionuklida karakteriziraju se kao rezidui i potrebno ih je odlagati 

na pravilan i zakonski propisan način.  
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Slika 2-4. Cijev za eksploataciju nafte i plina s naslagama (www.kamat.de) 

 

 

2.3. Pepeo iz termoelektrane na ugljen 

Spaljivanjem ugljena koji prirodno sadrži radionuklide u svome sastavu, dobiva se pepeo 

koji sadrži povećane koncentracije radionuklida, te ga kao takvog možemo smatrati kao 

rezidui i potrebno ga je skladištiti i odlagati na zakonom propisan način. Marović  i Bauman 

(1986) kažu kako je kod rada termoelektrana na ugljen, količina raspršene radioaktivnosti 

veća nego kod rada nuklearnih elektrana. Pošto su produkti izgaranja ugljena dim i pepeo, 

radionuklidi će se sasvim sigurno nalaziti i u dimu i u pepelu. Odgovarajućim modernim 

tehnologijama filtriranja otpadnih plinova iz termoelektrana, udio radionuklida u otpadnom 

plinu može biti smanjen za 99,5% (Marović i Bauman, 1986). Pošto se radionuklidi često 

nalaze vezani za krute čestice te se pomoću krutih čestica raspršuju u zrak, uklanjanjem 

krutih čestica iz produkata izgaranja može se znatno smanjiti sadržaj radionuklida u 

otpadnim plinovima termoelektrana na ugljen. U današnje vrijeme koriste se razne 

kombinacije uređaja kako bi se postigli odgovarajući rezultati pročišćivanja. Gotovo uvijek 
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se kao prethodni uređaji u sustavima pročišćivanja plinova koriste gravitacijski taložnici. 

Njihova svrha je odvojiti krute čestice iz struje otpadnih plinova koje imaju promjer veći od 

50 µm. Zatim se koriste aerocikloni koji su najviše primjenjivani uređaji u svrhu 

pročišćavanja otpadnih plinova (slika 2-5). Oni su namijenjeni za izdvajanje čestica 

promjera većeg od 5 µm. Kao zadnji stupanj pročišćavanja koriste se mokri kolektori. Mokri 

kolektori imaju mogućnost uklanjanja najsitnijih čestica iz otpadnih plinova, promjera 

manjeg od 10 µm i plinovitih onečišćujućih tvari iz otpadnih plinova kao naprimjer SO2.  

 
Slika 2-5. Shematski prikaz aerociklona (Sobota, 2021) 
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Međutim, isti ti uređaji na sebi zadržavaju koncentrirane radioaktivne tvari, stoga ih 

možemo svrstati u kategoriju rezidua i moramo ih zbrinuti na propisan način. Pepeo se 

najčešće odlaže u blizini termoelektrana na odlagalištima. Konstrukcija odlagališta pepela 

mora onemogućiti oborinskim vodama da dođu u kontakt s pepelom, onemogućiti 

raznošenje pepela djelovanjem vjetra i onemogućiti da pepeo dođe u direktan kontakt s 

podzemnim vodama. To se postiže izgradnjom temeljnog brtvenog sloja, koji se izrađuje od 

gline i geosintetika (najčešće geomembrane) i pokrovnog brtvenog sloja koji se izgrađuje od 

istih materijala (slika 2-6). Odlagalište mora sadržavati drenažni sloj, sustav kanala i 

spremnike za odvodnju i sakupljanje oborinske vode, koja bi u slučaju da dođe u tijelo 

odlagališta mogla negativno djelovati na kvalitetu okoliša ili na samo odlagalište. 

 

 
Slika 2-6. Prikaz presjeka odlagališta s brtvenim slojevima (Veinović, 2021) 
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 PRIMJENA GIS TEHNOLOGIJE 

Za potrebe ovog rada korištena je GIS tehnologija kako bi se kartirali i prostorno prikazali 

podaci dobiveni mjerenjem na lokaciji odlagališta pepela i šljake termoelektrane tvornice 

jugo-vinil u Kaštelima. Korišten je računalni program ArcMap 10.8.1. Podaci koji su 

korišteni u radu dobiveni su u obliku Excel tablice od instituta za medicinska istraživanja. 

Na lokaciji na kojoj se radi istraživanje mjerenja su izvođena na odabranim točkama čije su 

koordinate navedene u tablicama. Koordinate točaka su potrebne kako bi se podaci mogli 

prikazati u ArcMapu i dobiti zadovoljavajući rezultati na karti. Za svaku točku su rađena 

razna mjerenja od kojih će se samo pojedina koristiti u ovom radu. U radu će biti prikazane 

brzine doza, koncentracije radija i radona, koncentracije metala u tlu kao što su krom, bakar, 

cink, olovo i ostali. Područje na kojem je vršeno mjerenje podijeljeno je na 5 zona. Podaci o 

zonama su dobiveni u CAD formatu te su pomoću programa AutoCAD obrubljene zone, te 

su prebačeni u ArcMap i u njemu prikazani kao poligoni (slika 3-1). 

 

  
Slika 3-1. Lokacija zahvata s prikazom zona u obliku poligona (ArcMap) 

 

Zone su nazvane A (žuta boja), B (plava boja), C (ružičasta boja), D (zelena boja) i četiri 

poligona modro plave boje nazvana su ,,More''. U zoni A se nalazi lokacija stare deponije 

rudne jalovine s povećanom prirodnom radioaktivnošću. Zona B je lokacije koja je 

namjenski nasipavana šljakom, pepelom i ostalim građevinskim materijalima s prostora 

SFRJ tijekom 70-ih i 80-ih godina prošlog stoljeća. U zoni C se nalazi lokacija koja je nastala 

sanacijom odlagalište pepela i šljake iz zone A. Zona D je taložnica i od posebnog je interesa 

za istraživanje jer se na toj lokaciji skladištio pepeo i šljaka dobiveni iz ugljena korištenog u 

termoelektrani. Zona more je obrađena kako bi se utvrdilo ima li u moru pokraj lokacije 

štetnih učinaka i kako bi se utvrdile koncentracije radionuklida (Prlić, 2011). 
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Kako bi se u ArcMap-u mogle povezati lokacije zahvata sa stvarnim položajem na karti i 

iste prikazati, potrebno je u program učitati topografske i ortofoto karte. Karte su preuzete s 

Geoportala. Da bi se započelo raditi s podacima iz excela u ArcMap-u, potrebno je podatke 

u tablicama prilagoditi za rad u programu postavljanjem rezultata mjerenja u decimalni 

oblik, uklanjanjem razmaka u tekstualnom dijelu i uređivanjem tablica. Za rad u programu 

napravljene su 2 zasebne excel tablice s podacima. Prva tablica sadrži podatke o brzinama 

doza, a druga podatke o koncentracijama radona, radija i teških metala. Tablicu je potrebno 

pretvoriti u .xls oblik kako bi ju program mogao otvoriti. Zatim se tablice učitavaju u 

program pomoću naredbe Add XY Data (slika 3-2) koja se može pronaći pod File>Add 

Data>Add XY Data (slika 3-3). 

 
Slika 3-2. Dodavanje tablica iz Excela (ArcMap)  
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Slika 3-3. Add XY data (ArcMap) 

Prilikom dodavanja tablica potrebno je pod ,,X field'' postaviti kolonu širina koja 

predstavlja geografsku širinu točaka mjerenja, a pod ,,Y field'' kolonu dužina koja predstavlja 

geografsku dužinu točaka mjerenja. ,,Z field'' ostavljamo prazan. Koordinatni sistem se 

namješta na MGI_Balkans 5 jer su koordinate mjerenja označene u tom sustavu i karte u 

programu ArcMap su namještene u MGI_Balkans_5.  

Nakon što su tablice dodane u program, potrebno ih je pretvoriti u Shape file u obliku 

.shp te ih kao takve spremiti kako bi program mogao raditi s tim podacima. To je rađeno na 

način da se učitana excel tablica otvori desnim klikom miša, zatim se klikne ,,Data> Export 

Data''. (slika 3-4). Potrebno je odabrati mapu shp i spremiti shapefile unutra kako bi ju 

program mogao pronaći prilikom rada (slika 3-5). 
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Slika 3-4. Pretvaranje tablica u shapefile (ArcMap) 

 

 

Slika 3-5. Spremanje podataka u mapu shp (ArcMap) 

 

Napravljeni shapefile-ovi prikazani su kao slojevi u tablici sadržaja (eng. Table of 

Contents) (slika 3-6). Tamo se može uključiti ili isključiti njihova vidljivost. Kada su 

uključeni, prikazuju točke mjerenja na karti (slika 3-7). 
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Slika 3-6. Prikaz slojeva (ArcMap) 
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Slika 3-7. Prikaz točaka mjerenja (ArcMap) 

 

Sljedeći korak je izrada interpolacijske karte s podacima iz tablice. Interpolirani su podaci 

o brzinama doza (nGy/h), koncentracijama radona i radija i koncentracijama teških metala u 

točkama mjerenja. Interpolacija je napravljena na način da se pronađe izbornik 

Geoprocessing i u njemu odabere opcija ArcToolbox (slika 3-8). Kada se otvori ArcToolbox 

potrebno je odabrati Spatial Analyst Tools kao što je prikazano na slici 3-9., zatim je 

potrebno odabrati opciju Interpolation i metodu Natural Neighbor (slika 3-10). 

 
Slika 3-8. Geoprocessing (ArcMap) 
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Slika 3-9. Spatial Analyst (ArcMap) 
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Slika 3-10. Interpolacija (ArcMap) 

Interpolacijom su dobivene karte kao na slici 3-11. 

 

 

Slika 3-11. Interpolacija, prvi korak (ArcMap) 
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Dobiveno područje interpolacije potrebno je dodatno ograničiti jer su vršena mjerenja 

koja su pokazala da je prisutnost radionuklida i teških metala u moru negativna. Za granicu 

je uzeta morska obala. Orezivanje interpoliranog područja je izrađeno u nekoliko koraka. 

Pošto se interpolacijski grid ne može uređivati i orezivati u programu ArcMap, potrebno ga 

je prvo pretvoriti u poligon, a da bi to bilo moguće mora se prebaciti iz Floating point grida 

u Integer. To se radi pomoću alata Int zatim se nastali raster pomoću alata Raster to polygon 

pretvori u poligon te se kao takav spremi kao shapefile. Alat je napravio nekoliko desetaka 

tisuća poligona koje je potrebno združiti u uniju pomoću alata Union koji se nalazi u Editor 

toolbaru. Sljedeće je potrebno koristiti alat Cut polygons tools kako bi se izrezali neželjeni 

dijelovi poligona. Posljednje se koristi alat Extract by mask koji omogućava da 

interpolacijski grid bude orezan prema napravljenom poligonu u prošlom koraku. Na 

dobivene karte potrebno je postaviti kartografske elemente. Postavljeni su prikaz sjevera, 

traka mjerila, prikaz geografske širine i visine i legenda. Prikaz izrezanih interpolacijskih 

područja s kartografskim elementima može se vidjeti na slikama 3-12 do 3-24. Navedene 

slike su ujedno i završne karte koji prikazuju raspodjelu koncentracija obrađenih elemenata 

i izotopa te brzina doza na području tvornice Jugovinil u Kaštelima. 
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Slika 3-12. Interpolacijska karta brzina doza 
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Slika 3-13. Interpolacijska karta koncentracije radija 

 

 

 



 

21 
 

 

 

 

 
Slika 3-14. Interpolacijska karta koncentracije radona 
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Slika 3-15. Interpolacijska karta koncentracije bakra 
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Slika 3-16. Interpolacijska karta koncentracije cinka 
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Slika 3-17. Interpolacijska karta koncentracije kadmija 
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Slika 3-18. Interpolacijska karta koncentracije kobalta 
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Slika 3-19. Interpolacijska karta koncentracije kroma 
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Slika 3-20. Interpolacijska karta koncentracije mangana 
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Slika 3-21. Interpolacijska karta koncentracije nikla 
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Slika 3-22. Interpolacijska karta koncentracije olova 
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Slika 3-23. Interpolacijska karta koncentracije talija 
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Slika 3-24. Interpolacijska karta koncentracije željeza 
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 ODLAGALIŠTE PEPELA I ŠLJAKE TERMOELEKTRANE TVORNICE 
JUGOVINIL U KAŠTELIMA 

Odlagalište pepela i šljake termoelektrane tvornice Jugovinil nalazi se u Kaštelanskom 

zaljevu između Kaštel Gomilice i Kaštel Sućurca u Splitsko-dalmatinskoj županiji (slika 4-

1). Za vrijeme rada tvornice Jugovinil, 1947.-2001., koja je proizvodila plastične mase, 

postojala je potreba za električnom energijom koja se dobivala iz termoelektrane na ugljen 

u sklopu same tvornice. Termoelektrana u sklopu tvornice je otvorena 1949. godine. Otpad, 

koji je produkt rada termoelektrane je primarno pepeo nastao izgaranjem ugljena i leteći 

pepeo nastao pročišćavanjem otpadnih plinova. Pepeo nastao radom termoelektrane se 

odlagao u dvorištu tvornice na više mjesta u različitim periodima rada tvornice. Kako se za 

rad termoelektrane koristio ugljen s povišenim udjelima 238U i 226Ra, većinom iz istarskih 

ugljenokopa, tako su i na lokaciji odlagališta pepela pronađene povišene koncentracije 238U 

i ostalih radioaktivnih elemenata nastalih njegovim raspadom (Oreščanin, 2005). Oreščanin 

i dr. (2005) u svom radu navode kako je ugljen potreban za rad termoelektrane dovezen iz 

pet različitih ležišta, to je jasan razlog raznolikosti teških metala i radionuklida u otpadnom 

materijalu. Prlić (2011) u svom radu navodi kako se ,,U ugljenima koji su korišteni i 

spaljivani u termoelektrani tvornice Jugovinil nakon 1973. godine nalazili su se, kao i u svim 

ugljenim rudama, uz prirodne uranove izotope, 238U i 235U, i članovi njegovog radioaktivnog 

niza koji su u većini manje radioaktivni, ali im je radiotoksičnost veća''. (p. 78) Pepeo se do 

1973. godine odlagao u okolici postrojenja, kada je određena lokacija budućeg odlagališta. 

Otpadni materijal je premješten nekoliko stotina metara do mjesta odlagališta i tamo je 

odložen. Brtveni slojevi odlagališta su napravljeni od plastične folije i sloja gline, a pokrovni 

sloj od humusa. Krajem 1980-ih i početkom 1990-ih godine pepeo je odlagan direktno u 

more uz obalu sa svrhom nasipavanja obale.  
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Slika 4-1. Lokacija odlagališta pepela i šljake termoelektrane tvornice Jugovinil (Google Earth Pro) 
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 ZAKLJUČAK 

Pregledom završnih karata vide se područja na kojima se nalaze blago povećane 

koncentracije teških metala, radija, radona i brzina doza. Povećane koncentracije se 

uglavnom pojavljuju na tri mjesta. U zoni B, stotinjak metara zapadno od zone C i u zoni D. 

U zoni D nalaze se povećane koncentracije radija-226, kadmija i talija te velike brzine doza. 

Ta zona je služila kao taložnica i na toj lokaciji se skladištio pepeo i šljaka dobiveni od 

ugljena korištenog za rad termoelektrane. U zoni B se nalaze veće brzine doza, nešto 

povišene (detektabilne) koncentracije radija-226, radona, kadmija, kroma i talija. Zona B 

predstavlja područje namjenski nasipavano pepelom, šljakom i ostalim građevinskim 

materijalima s prostora SFRJ. Zona C je lokacija koja je nastala sanacijom odlagališta pepela 

i šljake 1974. godine. Stotinjak metara zapadno od zone C utvrđene su povišene 

koncentracije teških metala, prvenstveno bakra, cinka, kobalta, kroma, mangana, nikla, 

olova, talija i željeza. Dobiveni rezultati kartiranja su karte s izdvojenim područjima 

detektiranih materijala koje mogu poslužiti za određivanje eventualno potrebnih mjera 

sanacije lokacije. Naime, ukoliko bi se pokazalo da nađeni materijali i izmjerene brzine doza 

predstavljaju razlog za sanaciju lokacije, temeljem karata moguće je odrediti koliki je zahvat 

sanacije potreban pa i koju metodu primijeniti ukoliko treba provesti sanaciju. Obzirom da 

koncentracije i doze nisu velike, vjerojatno će biti moguće lokaciju urediti nanošenjem 

zemljanog materijala i ograničenjima po pitanju gradnje, odnosno dubine temelja. 
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